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1.1

1.2

1.2.1

1.2.2

Fundamentals | Overview

Overview

This chapter contains information about the product and these instructions.

Information on the product

Demo software for demonstration of the device functions

QUADRA-CHEK 2000 Demo is a software application you can install on a
computer independently of the device. QUADRA-CHEK 2000 Demo helps you to
become familiar with, try out or present the functions of the device.

Demo software features

Because of the missing hardware environment, the range of features of the demo
software does not correspond to the complete functional range of the device.

With QUADRA-CHEK 2000 Demo you can try out or present the following
features:

= "Conducting a measurement’

= "Displaying and editing the measurement results"

® "Creating a measurement report"

The following features cannot be tried out or presented with
QUADRA-CHEK 2000 Demo:

= Connecting measuring devices

= Connecting a network drive

B Connecting a USB mass storage device

= Connecting a printer
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Fundamentals | Intended use

1.3

1.4

1.5

1.6

Intended use

The products of the QUADRA-CHEK 2000 series are advanced digital evaluation
electronics for the measurement of 2-D features in metrology applications. The
products are used primarily on measuring machines and profile projectors.

QUADRA-CHEK 2000 Demo is a software product for demonstration of the basic
features of the QUADRA-CHEK 2000 series products. QUADRA-CHEK 2000 Demo
may be used only for presentation, training or testing purposes.

Improper use

QUADRA-CHEK 2000 Demo is not intended for any use other than the intended
use. Any use for other purposes is prohibited, specifically:

®  For productive purposes in production systems

B As part of production systems

Demo software for demonstration of the device
functions
QUADRA-CHEK 2000 Demo is a software application you can install on a

computer independently of the device. QUADRA-CHEK 2000 Demo helps you to
become familiar with, try out or present the functions of the device.

Notes on reading the documentation

Would you like to see any changes made, or have you found any errors?

We are continuously striving to improve our documentation for you. Please help us
by sending your requests to the following e-mail address:

userdoc@heidenhain.de
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Fundamentals | Symbols and fonts used for marking text

Symbols and fonts used for marking text

In these instructions the following symbols and fonts are used for marking text:

Depiction Meaning
> . Identifies an action and the result of this action
> .. Example:
» Tap OK
> The message is closed
I Identifies an item of a list
LI Example:

® TTL interface

m EnDat interface
[ ]

Bold Identifies menus, displays and buttons
Example:
» Tap Shut down
> The operating system shuts down
» Turn the power switch off
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2.1

2.2

2.3

12

Software Installation | Overview

Overview

This chapter provides all of the information needed for downloading and properly
installing QUADRA-CHEK 2000 Demo on a computer.

Downloading the installation file

Before you can install the demo software on a computer, you need to download an
installation file from the HEIDENHAIN Portal.

o To download the installation file from the HEIDENHAIN Portal, you
need access rights to the Software portal folder in the directory of the
appropriate product.
If you do not have access rights to the Portal's Software folder, you can
request the access rights from your HEIDENHAIN contact person.

» Download the latest version of QUADRA-CHEK 2000 Demo here:
www.heidenhain.de

> Select the download folder of your browser

» Unpack the downloaded file with the extension .zip into a temporary storage
folder

> The following files will be unpacked into the temporary storage folder:
B |nstallation file with the extension .exe
= File DemoBackup.mcc

System requirements

If you want to install QUADRA-CHEK 2000 Demo on a computer, the computer
system must meet the following requirements:

= Microsoft Windows 7 or higher
. Screen resolution of at least 1280 x 800 recommended
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Software Installation | Installing QUADRA-CHEK 2000 Demo under Microsoft Windows

2.4 Installing QUADRA-CHEK 2000 Demo under Microsoft
Windows

> Select the temporary storage folder into which you unpacked the downloaded
file with the .zip extension
Further information: "Downloading the installation file", Page 12

» Run the installation file with the extension .exe
> The installation wizard is opened:

g@ﬂetup ’?l =l

Setup Wizard

Figure 1: Installation wizard
> Tap Next

In the License Agreement installation step, accept the terms of the license
» Tap Next

0 In the Select Destination Location installation step, the
installation wizard suggests a storage location. WWe recommend
retaining the suggested storage location.

> In the Select Destination Location installation step, select the storage
location to which you want to save QUADRA-CHEK 2000 Demo

> Tap Next

0 In the Select Components installation step, the ScreenshotClient
program is also installed by default. ScreenshotClient enables you
to take screenshots of the active screen.

If you want to install ScreenshotClient

> In the Select Components installation step, leave the default
settings unchanged

Further information: "ScreenshotClient", Page 83

> In the Select Components installation step:
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Software Installation | Installing QUADRA-CHEK 2000 Demo under Microsoft Windows

m Select the type of installation
®  Activate or deactivate the option Screenshot Utility

ﬁj'ﬂetup

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue.

|Full installation P w
Demo
[¥] Screenshot Utlity 62 KB

Current selection requires at least 73, 1 MB of disk space.

< Back l[ Mext = J| Cancel

Figure 2: Installation wizard with activated demo software option and Screenshot
Utility
Tap Next

In the Select Start Menu Folder installation step, select the storage location at
which you want to create the start menu folder

Tap Next

In the Select Additional Tasks installation step, select or deselect Desktop
icon

Tap Next
Tap Install
Installation starts—the status of installation is shown in the progress bar

After installation has been completed successfully, use Finish to close the
installation wizard

The program has been successfully installed on your computer
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2.5 Uninstalling QUADRA-CHEK 2000 Demo

>

vV vV Y

Select in succession in Microsoft Windows:
= Start

u All programs

= HEIDENHAIN

= QUADRA-CHEK 2000 Demo

Tap Uninstall

The uninstallation wizard opens

To confirm unistallation, tap Ja

Unistallation starts, and the progress bar indicates the status of the unistallation
process

After uninstallation has been completed successfully, close the uninstallation
wizard with OK

The program has been successfully removed from your computer
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Basic Operation | Overview

3.1 Overview

This chapter describes the user interface, operating elements, and basic functions
of QUADRA-CHEK 2000 Demo.

3.2 Using the touchscreen and input devices

3.2.1 Touchscreen and input devices
The operating elements on the user interface from QUADRA-CHEK 2000 Demo
are operated via a touchscreen or a connected mouse.

To enter data, you can use the screen keyboard of the touchscreen or a connected
keyboard keyboard.
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Basic Operation | Using the touchscreen and input devices

3.2.2

Gestures and mouse actions

To activate, switch or move the operating elements of the user interface, you can
use QUADRA-CHEK 2000 Demo's touchscreen or a mouse. Gestures are used to
operate the touchscreen and the mouse.

o The gestures for operating the touchscreen may differ from the
gestures for operating the mouse.

If the gestures for operating the touchscreen differ from those for
operating the mouse, then these instructions describe both operating
options as alternative actions.

The alternative actions for operating the touchscreen or the mouse are
identified by the following symbols:

% Operation using the touchscreen

\Q Operation using the mouse

The following overview describes the different gestures for operating the
touchscreen or the mouse:

Tapping

Means pressing the left mouse button once

% Means touching the screen briefly with your fingertip

The actions initiated by tapping include
m Selection of menus, features or parameters
B Entering characters with the screen keyboard
m Closing dialogs
® Displaying and hiding the main menu in the Measure menu
® Displaying and hiding the Inspector in the Measure menu

Holding
Means touching the screen and holding your finger(s) on it for a
few seconds
Means pressing the left mouse button once and holding it
\Q down

The actions initiated by holding are

= Quickly changing the values in input fields with plus and
minus buttons
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Basic Operation | Using the touchscreen and input devices

Dragging
Is a combination of long press and then swipe, moving a finger
% over the touchscreen when at least the starting point of motion
is defined

Means pressing the left mouse button once and holding it
\Q down while moving the mouse; at least the starting point of the
motion is defined

The actions initiated by dragging include

t B Scrolling through lists and texts
~@®- B Opening the Details dialog in the Inspector
{

Two-finger drag

when at least the starting point of the movement is clearly

% Refers to the movement of two fingers across the touchscreen
defined

Refers to pressing the right mouse button once and holding it
\Q down while moving the mouse; at least the starting point of the
movement is defined

Two-finger dragging initiates the following action

) ® |n the Measure menu, moving the features view within the
~-90- workspace
‘
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Basic Operation | General operating elements and functions

3.3 General operating elements and functions

The operating elements described below are available for configuration and
operating the product via the touchscreen or input devices.

Screen keyboard

With the screen keyboard, you can enter text into the input fields of the user
interface. The displayed screen keyboard is either numeric or alphanumeric,
depending on the input field.

> To enter values, tap an input field

The input field is highlighted

The screen keyboard is displayed

Enter text or numbers

In some input fields, a green check mark indicates that the entry is correct

VvV V VvV VvV V

If the entry is incomplete or incorrect, a red exclamation mark is displayed. The
entry cannot be concluded in this case

To apply the values, confirm the entry with RET
> The values are displayed
> The screen keyboard disappears

v

Input fields with plus and minus buttons

To adjust a numerical value, use the + (plus) and - (minus) buttons to the left and
right of the numerical value.

0 ‘ o ‘ » Tap + or - until the desired value is displayed
> Long-press + or - to scroll through the values more

quickly
> The selected value is displayed

Toggle switch
Use the toggle switch to switch between functions.

> Tap the desired function
> The active function is shown in green

mm inch

> The inactive function is shown in light gray

Slide switch
With the sliding switch, you can activate or deactivate a function.

» Drag the sliding switch to the desired position or tap the
ON sliding switch

> The function is activated or deactivated

Slider
With the slider, you can continuously adjust values.

X » Drag the slider to the desired position
H > The selected value is displayed graphically or in percent
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Drop-down list

Basic Operation | General operating elements and functions

Buttons that open drop-down lists are indicated by a triangle pointing down.

-]
‘ 11 pApp ‘
Undo

4
>
>
4
>

Tap the button

The drop-down list opens

The active entry is highlighted in green
Tap the desired entry

The selected entry is applied

With this button, you can undo the last action.
Processes that have already been concluded cannot be undone.

Close

X

Confirm

v

Back

<

22

>
>

Tap Undo
The last action is undone

To add a feature, tap Add

The new feature is added

Tap Close to close a dialog

Tap Confirm to conclude an activity

Tap Back to return to the higher level in the menu
structure
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Basic Operation | QUADRA-CHEK 2000 Demo - startup and shut-down

3.4 QUADRA-CHEK 2000 Demo - startup and shut-down

3.4.1 Starting QUADRA-CHEK 2000 Demo

o Before using QUADRA-CHEK 2000 Demo, you need to perform the
steps for configuring the software.

» Tap QUADRA-CHEK 2000 Demo on the Microsoft Windows
desktop

or

» Select in succession in Microsoft Windows:
= Start
= All programs

HEIDENHAIN

QUADRA-CHEK 2000 Demo

0 Two executable files with different modes of
appearance are available:

= QUADRA-CHEK 2000 Demostarts within a
Microsoft Windows window

= QUADRA-CHEK 2000 Demo (full screen):
starts in full-screen mode

» Tap QUADRA-CHEK 2000 Demo or
QUADRA-CHEK 2000 Demo (full screen)

> QUADRA-CHEK 2000 Demo starts an output window in the
background. The output window is not relevant for operation
and is closed again when QUADRA-CHEK 2000 Demo is shut
down

> QUADRA-CHEK 2000 Demo starts the user interface with
the User login menu

HEIDENHAIN
QUADRA-CHEK 2023

Not logged in

Operator

Password

Figure 3: User login menu
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Basic Operation | QUADRA-CHEK 2000 Demo - startup and shut-down

3.42  Shutting down QUADRA-CHEK 2000 Demo

> Tap Switch off in the main menu

» Tap Shut down
> QUADRA-CHEK 2000 Demo is shut down

o To shut down QUADRA-CHEK 2000 Demo in the Microsoft Windows
window, also use the Switch-off menu.

If you use Close to close the Microsoft Windows window, all settings
will be lost.

3.5 User login and logout

In the User login menu, you can log in and out of the product as a user.

Only one user can be logged in to the product at a time. The logged-in user is
displayed. Before a new user can log in, the logged-in user has to log out.

o The product provides various authorization levels that grant the user full
or restricted access to management and operation functionality.

3.5.1 User login
rQ\ Tap User login in the main menu
. In the drop-down list, select the OEM user

Tap the Password input field

Enter the password "oem" of the OEM user

Confirm entry with RET

Tap Log in

The user is logged in and the Measure menu is displayed

VvV v v v v vy

3.5.2 User logout

» Tap User login in the main menu

v

Tap Log out
The user is logged out

A\

> All functions of the main menu are inactive, except for Switch
off

> The product can only be used again after a user has logged in
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Basic Operation | Setting the language

3.6

3.7

3.71

Setting the language

The default language for the user interface is English. You can switch the user
interface to the desired language.

> Tap Settings in the main menu

O

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

The language selected for the user is indicated by a national
flag in the Language drop-down list

> Select the flag for the desired language in the Language
drop-down list

> The user interface is displayed in the selected language

VvV v.v VY

User interface

User interface after Startup

User interface after startup

If automatic user login is active and the last user who logged in was of the
Operator type, the Measure menu with the workspace and the Inspector is
displayed after the product has started up.

If automatic user login is not active, the product opens the User login menu.
Further information: "User login menu", Page 33
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3.72 Main menu of the user interface

User interface with QUADRA-CHEK 2000 OED software option

mm

manual

¥

— oo

Figure 4: User interface with QUADRA-CHEK 2000 OED software option

1 Message display area, which displays the time and the number of unclosed
messages
2 Main menu with operating elements

Operating elements of the main menu
The main menu is displayed regardless of the activated software options.

Operating Function
element

- Message

Display of an overview of all messages as well as the
number of messages that have not been closed

Measure

Manual measurement, construction, and definition of
features by means of measuring programs and predefined
geometries

Further information: "Measure menu", Page 28

Measurement report

Creation of measurement reports based on templates
Further information: "Measurement report menu’,

Page 31

File management

Management of the files that are available on the product

Further information: "File management menu’,
Page 32

User login

Login and logout of the user

Further information: "User login menu", Page 33
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Basic Operation | User interface

Operating Function
element
Settings
@ Settings of the unit, such as setting up users, configuring

sensors, and updating the firmware
Further information: "Settings menu *, Page 34

Switch-off

d) Shutdown of the operating system or activation of energy-
saving mode

Further information: "Switch-off menu", Page 35
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Basic Operation | User interface

3.73 Measure menu

Activation

> Tap Measure in the main menu
> The user interface for manual measuring, constructing and

defining is displayed

Measure menu with QUADRA-CHEK 2000 OED software option

mm (074]

manal Temp

= vO
= oo
© Enter

Figure 5: Measure menu with QUADRA-CHEK 2000 OED software option

1 The function palette provides functions for manual measuring and defining. The
selected function is displayed as an active operating element.

2 The sensor palette contains the optional sensors (e.g., OED). It is only visible if
the software option is active.

3 The workspace displays, for example, the position display or the input area for
constructing and defining features.

4 The Inspector contains the quick access menu, the position preview, the
features preview, and the feature list or the program step list. The feature list
contains the features that have been measured, constructed, or defined.

5 The geometry palette provides all of the geometries for manual measuring,
constructing, and defining. The geometries are partially combined into
geometry groups. The selected geometry is displayed as an active feature. The
geometries available on the geometry palette depend on the selected function.

6 The tool palette provides the measuring tools required for conducting the
selected measurement.
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Basic Operation | User interface

Operating elements of the function palette

Manual Defining
measuring

Operating elements of the sensor palette

The operating elements of the sensor palette are only available if software options
are active. If one software option is active, the software option is displayed. If
multiple software options are active, you can choose between the options.

Optical edge
detection
(OED)
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Basic Operation | User interface

Operating elements of the geometry palette

Measure Magic

Line

Circle Arc Ellipse
O
Slot Rectangle

Distance Angle

Alignment Reference
plane

The Reference plane operat-
ing element is only available if
the Z axis is active.

Operating elements of the OED tool palette

The operating elements of the tool palette are only available if a software option
is active. They are only displayed in the manual measuring function if optical edge
detection is activated.

Crosshair OED Auto OED
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Basic Operation | User interface

3.74 Measurement report menu

Activation

> Tap Measurement report in the main menu

> The user interface for displaying and creating the
measurement reports appears

Short description

1

,.'-'\.\

L AllTol
Standard

{

EuraTol 2

(CTITTE ]

@ Standard <

rQ] MyCustomTemplated

Create
@ MyCustomTemplate2

Created

AN

Figure 6: Measurement report menu

1 List of default templates
2 Preview of the selected template
3 Display of information on the selected template

In the Measurement report menu, you can select report templates. A list of the

templates is shown in the left-hand column. A preview of the selected template is
displayed in the right-hand column.
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File management menu

Activation
B

Short description

A\
din o Internal

r
MASSSTORAGE 4

| Q2| DD

?

Basic Operation | User interface

N > Tap File management in the main menu
> The user interface for file management is displayed

Internal

Documents

Images

Programs

Reports

Svstem

Figure 7: File management menu

1 List of available storage locations

2 List of folders in the selected storage location

The File management menu shows an overview of the files stored in the unit’s

memory.
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3.76

User login menu

Activation
» Tap User login in the main menu
> The user interface for user login and logout is displayed

Short description

HEIDENHAIN
QUADRA-CHEK 2023

Logged in as

rQ] Operator

Figure 8: User login menu

1 Display of the logged-in user
2 User login

The User login menu shows the logged-in user in the column on the left. The login
of a new user is displayed in the right-hand column.

To log in another user, the logged-in user must first log out.
Further information: "User login and logout", Page 24
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Settings menu

Activation

> Tap Settings in the main menu

> The user interface for the device settings is displayed

Short description

A\
AN General @ Dewice information 1 4
Sensors @ Screen 14
@ Features % Display 1 4

o :

r-Q] Interfaces Ti Input devices 4
User ‘O] Sounds 14
( ) Axes 6\' Printers 4

Figure 9: Settings menu
1 List of setting options
2 List of setting parameters

The Settings menu shows all options for configuring the product. With the setting
parameters, you can adapt the product to on-site requirements.

0 The product provides various authorization levels that grant the user full
or restricted access to management and operation functionality.
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3.78

3.8

3.8.1

Switch-off menu

Activation

» Tap Switch off in the main menu

> The operating elements for shutting down the operating
system, for activating the energy-saving mode and for
activating the cleaning mode are displayed

Short description
The Switch off menu provides the following options:

Operating Function
element
Shut down
® Shuts down QUADRA-CHEK 2000 Demo

Energy saving mode

2 Switches the screen off and puts the operating system into
energy-saving mode

Cleaning mode

Switches the screen off; the operating system continues
unchanged

Further information: "QUADRA-CHEK 2000 Demo - startup and shut-down",
Page 23

Position display

The unit’s position display shows the axis positions and additional information
about the configured axes (if applicable).

Operating elements of the position display

Symbol Meaning

X

Axis key
Axis key functions:
B Tapping the axis key: Opens the input field for position value

= Holding down the axis key: sets the current position as zero
point

Reference mark search performed successfully

Reference mark search not performed or no reference mark
@ detected
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3.9 Working in the workspace

The workspace is only available in the Measure menu.

Activation

> Tap Measure in the main menu
> The user interface for manual measuring, constructing and

defining is displayed
3.9.1 Operating elements in the workspace

Operating elements of the manual measuring function for adjusting the
features view in the case of reduced workspace

Display Settings
annotations

Zoom functions

Regardless of the size of the workspace, the available functions are gathered
together in the Zoom functions.

Zoom Zoom to all Zoom to Magnify Reduce
functions selection graphic graphic

Bl Bl

Operating elements of the definition function

Depending on the selected geometry, the input fields required for definition are
displayed in the workspace.

mm 0Z1

manual Warld

Enter the ¢

e e

Figure 10: Operating elements of the Define function for the Circle geometry
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3.10 Using the Inspector

The Inspector is only available in the Measure menu.

Activation
H > Tap Measure in the main menu
> The user interface for measuring, constructing and defining is
displayed

3.10.1 Operating elements of the Inspector

Operating Short description
element
= - Quick éccess menu | |
The quick access menu displays the current settings for
manual World manual measuring, constructing and defining:
= Unit of measurement for linear values (millimeters or
inches)

®  Magnification used

= Type of measuring point acquisition (automatic or
manual)

Coordinate system used

» To adjust the settings of the quick access menu, tap the
quick access menu

Position preview

The position preview is only available in the manual

measuring function.

The current axis positions are displayed. If no reference

mark search has been performed, the axis positions are

displayed in red.

» To display the position preview in the workspace, tap
the Position preview

> The position preview is displayed in the workspace

> The current content of the workspace switches to the
Inspector

Features preview

The features preview is available only in the measuring
function.

The features preview displays a reduced view of the
measured, constructed and, defined features.

» To display the features view in the workspace, tap
Features preview

> The features view is displayed in the workspace

> The current content of the workspace switches to the
Inspector
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Operating Short description
element
Feature list

The feature list contains a list of all features that have been

measured, constructed, or defined. The feature list provides

the following information:

= 1: Measured feature with symbol, name, and
consecutive number

®  2: Function that was used for creating the feature

Symbol Meaning
H Measured feature
Constructed feature

Defined feature

®  3: Concludes the measuring point acquisition
® 4: Number of measuring points that have been acquired
m 5: Newly acquired feature with symbol

Each feature contains details on the measurement results
as well as selectable tolerances.

» To display the measured values and adjust the
tolerances, drag a feature into the workspace

> The detail window with the Overview and Tolerance
tabs opens in the workspace

> To select or deselect features, tap the features in
succession

> The selected features are highlighted in green

» To delete a feature, drag the feature to the right and out
of the Inspector

Measurement result preview

X
B ssre Wl oo The measurement result preview is displayed in the
BJ‘ 7 g i workspace after a measurement process is concluded and
E ::1 o shows information about the measured feature. For each
- — geometry time, it is possible to define which parameters
are shown in the measurement result preview. The respec-
tive geometry type determines which parameters are avail-

able.
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Operating Short description
element
Initialization Program step list

The program step list shows all actions that occur during
the measurement. It is displayed instead of the feature list
in the Inspector.

The program steps can be combined and saved as measur-

Auto enter

Units

Start OED

Start OED

Calculate Alignment 1

Auxiliary functions
The auxiliary functions contain the following functions:

® Switching the display between feature list and program
step list

Creating, saving, and opening a program

Calling the program control in the workspace
Opening and saving a coordinate system

Deleting selected features or all features from the
feature list

VO Feature selection
oo Multiple selection of features of the same geometry type
» Tap Feature selection

» To select all features of a geometry type in the feature
list, tap the desired geometry type

» Confirm with OK
> The selected features are highlighted in green

Enter
© Enter Acquisition of measuring points with the following options:
® [f measuring point acquisition is deactivated, then the
measuring points will be acquired manually
é — m |f automatic_ measuring point acquisit_ion is active, then
a red dot will be shown in the operating element. The

measuring points will be acquired after expiration of the
set timeout
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3.11  Using measuring tools

o The operating elements of the tool palette are only available if an optical
sensor is active. They are shown in the manual measuring function with
the following views of the workspace:
With OED optical sensor, if the position display or the features view is
in the workspace

3.11.1  Measuring tools

Depending on the optical sensor, various measuring tools are available for
acquiring the measuring points. The measuring tools can be operated by gestures
in the workspace.

OED measuring tools

Symbol Measuring tool Functions and characteristics

Crosshair ®  Manual acquisition of single measuring points
= No automatic acquisition of light-to-dark transitions

OED = Active measuring tool
B Acquisition of light-to-dark transitions

= Buffering of a single measuring point (manual
confirmation required)

If the OED sensor traverses an edge, a measuring

point is buffered in the clipboard. If the OED sensor

traverses a further edge, the buffered measuring

point is overwritten. By tapping Enter, the previously

buffered measuring point is added to the feature calcu-

lation.

Auto OED = Active measuring tool
= Automatic acquisition of measuring points, e.g. on
circles and circular arcs
B Acquisition of light-to-dark transitions
If the OED sensor traverses an edge, a measuring
point is automatically acquired and added to the
feature calculation.
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Software Configuration | Overview

Overview

o Make sure that you have read and understood the "Basic Operation”

chapter before carrying out the actions described below.
Further information: "Basic Operation’, Page 17

Before you can use QUADRA-CHEK 2000 Demo correctly after successful
installation, you need to configure QUADRA-CHEK 2000 Demo. This chapter
describes how to perform the following settings:

Activating a license key

Copying the configuration file
Uploading the configuration file

Setting the language

Selecting the product version (optional)
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4.2 Activating a license key

With QUADRA-CHEK 2000 Demo, you can also simulate functions that are
dependent on a software option. To do so, you must enable the software option
with a license key. The required license key is stored in a license file in the folder
structure of QUADRA-CHEK 2000 Demo.

You must upload the license file in order to enable the available software options.

> Tap Settings in the main menu

> The unit's settings appear

Device information 4
Sensors Screen b
Features Display 4
Interfaces

Input devices 4

User Sounds b

4D P o8

Printers 4

Figure 11: Settings menu

% > Tap Service
Open in the sequence

= Software options
= Activate options
= Tap Read license file
> Select the storage location in the dialog:
® Select Internal
® Select User
Select the PcDemoLicense.xml license file
Confirm your selection with OK
Tap OK
The license key is activated
Tap OK
You are prompted to restart
Use Cancel to deny restarting

The functions dependent on the software options are
available

vV VvV VvV VvV V VvV VvVYy
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Copying the configuration file

Before you can load the configuration data in QUADRA-CHEK 2000 Demo, you

must first copy the downloaded configuration file DemoBackup.mcc to an area

that can be accessed by QUADRA-CHEK 2000 Demo.

» Move to the temporary storage folder

» For example, copy the configuration file DemoBackup.mcc to the following
folders:C: » HEIDENHAIN » [product name] » Metrology » ProductsMGE5
» [product designation] » user » User

6 In order for QUADRA-CHEK 2000 Demo to access the
configuration file DemoBackup.mcc, you must retain the following
part of the path when you save the file: » [product name]
» ProductsMGE5 » Metrology » [product abbreviation] » user
» User.

> The configuration file can be accessed by QUADRA-CHEK 2000 Demo
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4.4 Uploading the configuration file

o Before you can upload the configuration data, you must first activate
the license key.

Further information: "Activating a license key", Page 43

In order to configure QUADRA-CHEK 2000 Demo for the application on the
computer, you must upload the configuration file DemoBackup.mcc.

> Tap Settings in the main menu

> The product settings are displayed

Device information 4
Sensors Screen 4
Features Display »
Interfaces Input devices 4
User

Sounds 4

Axes Printers 4

o D P e e

Figure 12: Settings menu
% » Tap Service
» Openin the sequence
® Back up and restore
= Restore settings
= Complete restoration
> Select the storage location in the dialog:

5 Internal
= User

> Select the DemoBackup.mcc configuration file

» Confirm your selection with OK

> The settings are applied

> You are prompted to shut down the application

> Tap OK

> QUADRA-CHEK 2000 Demo is shut down, and the Microsoft
Windows window is closed

» Restart QUADRA-CHEK 2000 Demo

> QUADRA-CHEK 2000 Demo is ready for use
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4.6
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Software Configuration | Setting the language

Setting the language

The default language for the user interface is English. You can switch the user
interface to the desired language.

> Tap Settings in the main menu

O

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

The language selected for the user is indicated by a national
flag in the Language drop-down list

> Select the flag for the desired language in the Language
drop-down list

> The user interface is displayed in the selected language

VvV v.v VY

Selecting the product version (optional)

QUADRA-CHEK 2000 is available in different versions. These versions differ in their
interfaces for connectible encoders:

® QUADRA-CHEK 2013 version for encoders with 1 Vpp interface

5= QUADRA-CHEK 2023 version for encoders with TTL interface

= The QUADRA-CHEK 2093 version for encoders with various interfaces (1 Vpp
and TTL)

In the Settings menu, you can select the version that is to be simulated with
QUADRA-CHEK 2000 Demo

> Tap Settings in the main menu

% Tap Service
Tap Product designation

Select the desired version

You are now prompted to perform a restart

QUADRA-CHEK 2000 Demo is ready for use in the desired
version

VVVvyvVvYyy
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Quick Start | Overview

Overview

In this chapter an example is used to describe the steps of a typical measuring
sequence. The steps range e.g. from aligning the measured object and measuring
the features through to creating the measurement report.

@ For a detailed description of the individual activities, please refer to the
"Measuring," "Measurement evaluation" and "Measurement reports"’
chapters in the QUADRA-CHEK 2000 operating instructions.

o Make sure that you have read and understood the "Basic Operation”
chapter before carrying out the actions described below.

Further information: "Basic Operation’, Page 17
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5.2

5.2.1

Conducting a measurement

Measuring with an OED sensor

o The measurements shown here cannot be simulated with QUADRA-
CHEK 2000 Demo, because the corresponding measuring point
acquisition is not possible without a measuring device and OED sensor.
However, you can use the descriptions to familiarize yourself with the
most important functions and the user interface.

For the measurement of edges and contours with an OED sensor, various
measuring tools are available to you for the acquisition of measuring points.

Further information: "Measuring tools", Page 40

Aligning the measured object

Before you can evaluate the measuring points, you need to align the measured
object. During this process, the coordinate system of the measured object
(workpiece coordinate system) is determined, which is specified in the technical
drawing.

This makes it possible to compare the measured values with the data in the
technical drawing and assess them.

&
HEIDENHAIN &

11T e
\

3.

Figure 13: Example of aligning a 2-D demo part

Measured objects are usually aligned in the following steps:
1 Measuring the alignment

2 Measuring a straight line

3 Constructing the zero point
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Quick Start | Conducting a measurement

Measuring the alignment
Define the reference edge for the alignment according to the technical drawing.

. > Tap Measure in the main menu
A\
> Select Manual measuring in the function palette
» |If multiple sensors are activated, then select OED sensor in
the sensor palette

> The geometry palette and the OED measuring tools are now
displayed
> The workspace now shows the position display

» In the quick access menu, select the magnification that is set
on the measuring machine

> Select Alignment in the geometry palette

> Select Auto OED in the tool palette

» Cross over the reference edge multiple times with the OED
sensor

> A new feature is displayed in the feature list of the Inspector

> A new measuring point is added for each pass over the
reference edge

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

» Tap Finish in the new feature
> The alignment is displayed in the feature list of the Inspector
> The measurement result preview is now displayed

mm 0zZ1

manual Temp

" Alignment 1
T A

- v0O
= aa]
r

Figure 14: Alignment feature in the feature list with Measurement result preview
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Quick Start | Conducting a measurement

Measuring a straight line
A straight line is measured as the second reference edge.

> Select Line in the geometry palette

Select Auto OED in the tool palette

Cross over the reference edge multiple times with the OED
sensor

A new feature is displayed in the feature list of the Inspector

A new measuring point is added for each pass over the
reference edge

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

Tap Finish in the new feature
The line is displayed in the feature list of the Inspector
The measurement result preview is now displayed

mm 0z1

manual Temp

1 X] -aet

[0 270116
L) Temp
Lﬁ Gaussian

Figure 15: Line feature in the feature list with Measurement result preview
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Quick Start | Conducting a measurement

Constructing the zero point

The zero point is constructed from the point of intersection between the alignment
and the straight line.

> Select Zero point in the geometry palette

> Select the Alignment and Line features in the Inspector orin
the features view

The selected features are displayed in green

A new feature with the selected geometry is displayed
Tap Finish in the new feature

The zero point is created

The workpiece coordinate system for the measured object
has been determined

Tap Features preview
> The coordinate system is shown in the workspace

[<]
VV Vv VYV

v

mm 0Z1

manual Temp

0.007
25.370

>

Figure 16: Workspace with zero point displayed in the coordinate system
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Quick Start | Conducting a measurement

Measuring features

To measure features, you can use the geometries of the geometry palette.

HEIDENHAIN

T
A

Figure 17: Examples of measuring a 2-D demo part

The section below describes measuring the following features:
1 Circle

2 Slot

3 Blob
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Measuring a circle

A minimum of three measuring points is required to measure a circle. For
measuring point acquisition, you can use the OED measuring tool, for example.

» Tap Measure in the main menu
"
> Select Manual measuring in the function palette
> |If multiple sensors are activated, then select OED sensor in
the sensor palette

> The geometry palette and the OED measuring tools are
displayed
> The workspace now shows the position display

> In the quick access menu, select the magnification that is set
on the measuring machine

> Select Measure Magic in the geometry palette
or
» Select Circle in the geometry palette
» Select OED in the tool palette
s » Cross over the edge of the circle with the OED sensor

multiple times
> The unit records the measuring point in the clipboard

» To confirm the measuring point acquisition, tap Enter in the
Inspector

© Enter

> A new feature is displayed in the feature list

o A new measuring point is recorded every time
you cross over an edge of the feature to be
measured using the OED sensor. The clipboard
is updated with the newly recorded measuring
point. If you tap Enter in the Inspector, then only
the most recently acquired measuring point is
confirmed.

» To acquire more than one measuring point along the edge,
repeat the process

» Tap Finish in the new feature

> A new feature is calculated from the captured measuring
points and the selected geometry

> The measured circle is displayed in the features preview
> The measurement result preview is now displayed
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| X 68.404
\R] 5791
{L!J Temp

- Gaussian

Y 2ram
\D| 11583

mm 0Z1

manual Temp

Ling |
V=N

{  Zeropoint 1

A

| . Circle 1
v A

© Enter

Figure 18: Circle feature in the feature list with Measurement result preview
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Measuring a slot

A minimum of five measuring points is required in order to measure a slot. For
measuring point acquisition, you can use the Auto OED measuring tool, for
example. Place at least two measuring points on the first long side and one
measuring point on the second long side, and at least one measuring point on
each arc of the slot. You can capture the points in any sequence.

. > Select Slot in the geometry palette

> Select Auto OED in the tool palette

S » Cross over the edge of the slot multiple times with the OED
sensor

> A new feature is displayed in the feature list

> A new measuring point is added for each pass over the
reference edge

0 Distribute the measuring points along the entire
length of the first side, as far as possible.

» Tap Finish in the new feature

> A new feature is calculated from the captured measuring
points and the selected geometry

> The measured slot is displayed in the features preview
> The measurement result preview is now displayed

mm 0Z1

manual Temp

Figure 19: Slot feature in the feature list with Measurement result preview
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Measuring a blob

A minimum of three measuring points is required to measure a blob. For
measuring point acquisition, you can use theAuto OED measuring tool, for
example. Multiple measuring points are automatically distributed along the entire
contour according to the specified settings.

E > Select Blob in the geometry palette

> Select Auto OED in the tool palette

S » Cross over the edge of the blob multiple times with the OED
sensor

> A new feature is displayed in the feature list

> A new measuring point is added for each pass over the
reference edge

0 Distribute the measuring points as evenly as
possible along the contour of the feature.

> Tap Finish in the new feature

> A new feature is calculated from the captured measuring
points and the selected geometry

> The measured blob is displayed in the features preview
> The measurement result preview is now displayed

mm 0Z1

manual Temp

Figure 20: Blob feature in the feature list with Measurement result preview

5.2.2 Displaying and editing the measurement results

You can edit the measured features immediately after capturing the measuring
points. Drag individual features into the workspace and edit them in the Details
dialog.
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Short description

1 2

A

11.7089 Zero

Cirde 1

<

-2.1224 Zero

N

0.0000 Zero

Welt >

i

6.2570

Form deviation 0.0386

Number of points 30 0f 31

Fitting algorithm Gaussian hd

Hinweis

NeNeNa e e

New type of geometry Point et

Figure 21: Overview tab in the Details dialog

1 Name of the feature

2 Axis positions of the center point

3 The coordinate system to which the coordinate values of the feature are
referenced

4 Feature parameter dependent on the geometry type: For the circle geometry
type, it is possible to switch between radius and diameter

5 Number of measuring points used for calculating the feature

6 Fitting algorithm used for calculating the feature; depends on the geometry and
the number of measuring points

7 Informational text field; if an annotation is active, then its contents are shown in
the features view as an annotation

8 List of geometry types to which the feature can be converted

9 View of the measuring points and the form

Renaming a feature

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
Tap the input field containing the current name

Enter a new name for the feature

Confirm entry with RET

The new name is displayed in the feature list

VvV Vv VvV VvVYVYy

X Tap Close to close the dialog
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Changing the Fitting algorithm
You can adjust the fitting algorithm depending on the measured feature. The
Gaussian fitting algorithm is used by default.

» Move a feature (e.g., a Circle) from the features list into the
workspace

The Details dialog appears with the Overview tab selected
The fitting algorithm used is shown in the Fitting algorithm
drop-down list

In the Fitting algorithm drop-down list, select the desired
fitting algorithm (e.g., Min. circumscribed)

The feature is displayed according to the selected fitting
algorithm

VvV VvV

v

\'

Figure 22: Circle feature with new fitting algorithm
> Tap Close to close the dialog
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Quick Start | Conducting a measurement

Converting a feature

The feature can be converted to a different type of geometry. The list of possible
geometry types is provided as a drop-down list in the Details dialog.

Drag the Slot feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
The geometry type of the feature is displayed

In the New type of geometry drop-down list, select the
Point type of geometry

vV vV Yy

o The 2-D profile geometry type is currently not
yet supported.

> The feature is displayed in the new form

Figure 23: Type of geometry changed from Slot to Point
X » Tap Close to close the dialog
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Changing Tolerances

On the Tolerances tab, you can adjust the tolerances for a measured feature. The
tolerances are grouped.

Overview Tolerances X

General tolerances 150 2768°fH »

Size tolerances ] @ Circle 1 -(2 n(i / »
(] @ Gircle 1 -@ 14

Form tolerances 1] O Roundness b

Location tolerances 1] '@- Position »

[x] @ Concentricity 4

Runout tolerances Q / Runout 4
3

Figure 24: Details dialog with Tolerances tab

1 Display of general tolerance

2 List of tolerances, depending on feature

3 Status of the tolerance: Active and within the tolerance or active and outside
the tolerance

In the Tolerances tab, you can define the geometrical tolerancing of a feature. The
tolerances are grouped.

» Drag a feature (e.g., Circle) from the feature list into the
workspace

The Details dialog appears with the Overview tab

Tap the Tolerances tab

The tab for tolerancing the selected feature is displayed
Tap the size tolerance X

An overview of the selected size tolerance appears

VvV vV VvV

/\

Overview Tolerances x

4 @ Circle 1 ;
/S oa
Ll Lsoam -] g

3
Upper tolerance

Mominal dimension 68.390

3
Actual value 68.390 Lower tolerance

Deviation 0.000

Figure 25: Overview of Size tolerance with activated size
tolerance X
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Quick Start | Conducting a measurement

Activate tolerancing of the measured value with the ON/OFF
slide switch

The selection and input fields become active

Tap the Nominal dimension input field and enter 76.2
Confirm entry with RET

Tap the Upper tolerance input field and enter 0.1
Confirm entry with RET

Tap the Lower tolerance input field and enter 0.1
Confirm entry with RET

The nominal value is shown in red if it is out of tolerance
The nominal value is shown in green if it is within tolerance
Tap Back

The Tolerances tab is displayed

Symbols are used to display the result of the tolerance check
on the Tolerances tab and, after closing the dialog, in the

feature list
0 Activated tolerances are maintained
8 One or more activated tolerances are exceed-

ed
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Quick Start | Conducting a measurement

Adding annotations

You can add an annotation to every feature in the features view (e.g.,
measurement information or informational texts).

3

mm 0z1

manual Temp

18.826
2.533
9.465

£ro point 1

Figure 26: Operating elements for annotations and feature with annotations

1 Edit annotations operating element

2 Operating elements for adding annotations
3 Measurement information

4 Explanatory text
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Quick Start | Conducting a measurement

5.2.3 Creating a measurement report
You can create a measurement report in four steps:
m "Selecting the template and features'
B "Entering information on the measuring task"
® "Selecting document settings"
® "Exporting a measurement report"

Selecting the template and features

> Tap Measurement report in the main menu

> The user interface for editing the measurement reports
appears

Select the Standard template

Tap Create to create the measurement report

The Features menu appears with a list of all features that
have been measured, constructed, and defined

>
> The preview of the selected template is displayed
>
>

v

To add all features to the measurement report, tap Select all
in the Select drop-down list

> All features in the list and in the features preview are
activated and displayed in green

Sort by

Line 1

Information Zero point 1

Document Circied

Preview St

Slot2

@ Circle 2

Figure 27: Measurement report menu with feature list and features
view
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Filtering features

You can filter the feature list in the Features menu by various criteria. By this
means, only those features are shown that fulfill the filter criteria (e.g., only circles
with a certain minimum diameter).

You can use any combination of filters.

X

vV vYVvyyvVvyy

Tap the Filter drop-down list

Select the desired filter criterion in the dialog
Select the operator

Select the function

In order to deactivate a filter criterion, deselect it

> Tap Close to activate the filter criteria

Filter precon- Operator Function
dition
Type Is Only features of the selected geometry type
are shown.
Is not Only features of the non-selected geometry
type are shown.
Size Equal Only features of the specified size are shown.
Greater than  Only features that are larger than the specified
size are shown.
Less than Only features that are smaller than the speci-
fied size are shown.
Tolerance Is Only features that fulfill the selected character-
istic are shown:
= Passed
= Failed
B Inactive
Is not Only features that do not fulfill the selected
characteristic are shown.
Selection Is Only the selected features are shown.
Is not Only the non-selected features are shown.
Creation type Is Only features that fulfill the selected character-
istic are shown.
Is not Only features that do not fulfill the selected

characteristic are shown.
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Entering information on the measuring task

o The information entered depends on the configuration of the template.

Tap the Information menu
In the Job input field, enter Demo1 to identify the measurement job
Confirm entry with RET

Enter the part number 681047-02 of the measured object into the Part number
input field
» Confirm entry with RET

vV v Vvy

Selecting document settings
» Tap the Document menu

» Select the YYYY-MM-DD hh:mm (date and time) format in the Date and time
format drop-down list

» Tap the Preview menu
> The preview of the measurement report is displayed

AeasurEment repor Dased on template *Siandard”
Tne implemented template cesigner slows 10 cusmize

Features e auBilabie EMEIES Of 10 CTBAIE NeW ONEs
Information =

ENTERPRISE

Document

Save as

Figure 28: Preview of the measurement report

Exporting a measurement report

Measurement reports can be exported as PDF or CSV files.

Select the Export as PDF export format in the Export drop-down list
Select the Internal/Reports storage location in the dialog

Enter the name Demo1 for the measurement report

Confirm entry with RET

Tap Save as

The measurement report is exported in the selected format and stored in the
storage location

vV v v vy
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Canceling a measurement report or closing it after saving

» Tap Close
» Close the message with OK
» The measurement report is closed

X

Opening a measurement report
In the File management main menu, you can open the saved report.

ii > Tap File management in the main menu

Select the Internal/Reports storage location

> Select the desired Demo1.pdf file
> A preview image as well as information about the file are
displayed
< Internal/Documents OEMServiceHints.pdf
A
[]  OEMServiceHtints.pdf 4
[ QC3KServiceHints.pdf
View Print
Created
09/29/2017 12:28:56
Last changed
Q e
@ File size
Number of pages
(D 2

Figure 29: Preview of the measurement report and file information
» To display the measurement report, tap View
> The file contents are displayed
» Tap Close to close the view
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Measurement Report Template | Overview

Overview

This chapter describes how you can create your own measurement report
templates with QUADRA-CHEK 2000 Demo and transfer them to your unit so that
you can use the templates for creating measurement reports on your unit.

o Make sure that you have read and understood the "Basic Operation'
chapter before carrying out the actions described below.

Further information: "Basic Operation’, Page 17

Short description

In the Measurement report menu, you can create detailed reports for your
measuring tasks. You can document one or more measured features in a
measurement report. The measurement reports can be printed, exported and
saved. For the creation of measurement reports, you can choose between several
standard templates.

With the QUADRA-CHEK 2000 Demo PC software, you can create your own
report templates and then transfer them to your unit. Your own custom templates
then appear next to the standard templates in the Measurement report menu and
can be used for creating measurement reports.

Activation
> Tap Measurement report in the main menu
2
1
,.'-‘\.\
e AllTol
Standard
’
EuraTol Mﬂ?@ ;
=2 [T
.] Standard
rQ] MyCustomTemplated

Create

@ MyCustomTemplate2
Created

3

Figure 30: Measurement report menu

1 List of default templates
2 Preview of the selected template
3 Display of information on the selected template
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6.2 Creating and editing a template

With the editor, you can create your own custom measurement report templates:
Opening a new template with the editor

Editing the default settings for the measurement report

Configuring the page header

Configuring the report header

Defining the data for the measurement report

Saving the template

vV Vv Vv VvYVvyy
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Measurement Report Template | Creating and editing a template

Opening a new template with the editor

> Tap Measurement report in the main menu

» Maximize the window of the software on the computer
screen

> The Add button appears in the list of templates

AllTol

EuroTol

Standard

Standard

MyCustomTemplate1

MyCustomTemplate2

+

Create

Created
09/29/2017 12:28:56.

Last changed
03/16/2017 13:09:42

Last opened
09/29/2017 12:28:56

Figure 31: Measurement report menu with the list of templates and the Add button

_|_

D

Page header

Report header

Data

» Tap Add to create a new template
> The Default settings for the template are displayed

Template AllTol.xmt
Unit for linear values Millimeters

cimal places for linear values
Unit for angular values Decimal degrees v
Decimal places for angular values

Date and time format hh:mm DD-MM-Y... ¥

| |
w IS
e e < Ll

Grid size

|
5
E

Display page header

Display report header

Display feature view

Figure 32: Editor for measurement report templates
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6.2.2  Editing the default settings for the measurement report

4

Select the default template you want to use as the basis in
the Template drop-down list

Select the desired unit of measurement in the Unit for
linear values drop-down list

To reduce or increase the number of displayed Decimal
places for linear values, tap —or +

Select the desired unit of measurement in the Unit for
angular values drop-down list

Select the desired format in the Date and time format drop-
down list

To reduce or increase the Grid size, tap - or +

o The grid for the auxiliary lines can be set
between 5 and 50. The auxiliary lines are
displayed only in the editor. The smaller the
spacing is between the auxiliary lines, the more
precisely the fields and columns of the form can
be positioned.

To show the page header in the template, activate Display
page header with the ON/OFF sliding switch

To show the report header in the template, activate Display
report header with the ON/OFF sliding switch
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Measurement Report Template | Creating and editing a template

6.2.3 Configuring the page header

» Tap Page header

o The menu is only available if the Display page
header setting is active in the Default settings
menu.

Timestamp  [¥/]

ENTERPRISE

Figure 33: The page header of a measurement report template

1 The different sections of the template can be edited in the editor menu.

2 The form fields for the template are adjustable.

3 The list shows the form fields that can be inserted into the selected section of
the template.

4 'Grid" operating element for displaying and hiding the auxiliary lines in the
editor.

» Tap Grid to display or hide the grid of auxiliary lines

=

o The grid of auxiliary lines is always active. All
fields of the form are automatically aligned with
it.
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Inserting or removing form fields

The form fields listed below can be inserted into the page header of the
measurement report. During the creation of the measurement report, the form
fields are filled according to the entries made.

» To insert or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark

> The form field is inserted into the template or removed from
the template

Form field Meaning and application

Timestamp The date and time are inserted.

Job The job is inserted.

User name The user name is inserted.

Part number The part number is inserted.

Fixed text Fixed text is inserted into the template.

> Tap the Fixed text form field in the template
> Aninput field opens

> Enter the desired text
>

To close the input field, tap anywhere outside
the input field

Variable text Variable text is inserted. You can type the variable
text into the template. When creating the
measurement report, you can overwrite the text as
needed.

Logo A logo is inserted.
» Tap the Logo form field in the template
> A dialog appears
> Select the desired logo in the storage location
>
>

Tap OK to close the dialog
The logo is inserted into the template

Resizing a form field

You can adjust the size of the form field using the square handles at the corner of
the field.

» Tap Grid to use auxiliary lines for easy alignment

» Drag the square handle of the corresponding form field to the
desired size

> If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied

Positioning a form field

You can position the form fields in the template according to your own
preferences.

Tap Grid to use auxiliary lines for easy alignment

Drag the form field to the desired position in the template
If form fields overlap, the affected area is highlighted in red
The change to the form field is applied

\ 22 A 4
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6.2.4  Configuring the report header

» Tap Report header

o The menu is only available if the Display report
header parameter is active in the Default
settings menu.

Timestamp [l

SORFCHEK 3014 NC
088014

Default settings

Page header

Omitted
features

Failed
tolerances

Product
designation

Figure 34: Report header of a measurement report template

1 The different sections of the template can be edited in the editor menu.

2 The form fields for the template are adjustable.

3 The list shows the form fields that can be inserted into the selected section of
the template.

4 'Grid" operating element for displaying and hiding the auxiliary lines in the
editor.
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Inserting or removing form fields

The form fields listed below can be inserted into the report header of the
measurement report. During the creation of the measurement report, the form
fields are filled according to the entries made.

» To insert or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark

> The form field is inserted into the template or removed from
the template

Form field Meaning and application
Timestamp The date and time are inserted.
Job The job is inserted.
User name The user name is inserted.
Part number The part number is inserted.
Fixed text Fixed text is inserted into the template.
> Tap the Fixed text form field in the template

> Aninput field opens
> Enter text
>

To close the input field, tap anywhere outside
the input field

Variable text Variable text is inserted. You can type the variable
text into the template. When creating the
measurement report, you can overwrite the text as
needed.

Logo A'logo is inserted.
» Tap the Logo form field in the template
> A dialog appears
> Select the desired logo in the storage location
» Tap Select to close the dialog
> The logo is inserted into the template

Omitted features The number of measured features that are not
displayed in the measurement report is inserted.

Failed tolerances The number of features that are out of tolerance is
inserted.

Product designation The product designation of the product is inserted.

Serial number The serial number of the product is inserted.

Firmware version The firmware version currently installed on the

product is inserted.

Resizing a form field

You can adjust the size of the form field using the square handles at the corner of
the field.

> Tap Grid to use auxiliary lines for easy alignment

» Drag the square handle of the corresponding form field to the
desired size

> |If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied
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Measurement Report Template | Creating and editing a template

Positioning a form field

You can position the form fields in the template according to your own
preferences.

Tap Grid to use auxiliary lines for easy alignment

Drag the form field to the desired position in the template
If form fields overlap, the affected area is highlighted in red
The change to the form field is applied

vV Vv Vv Yy

Defining data for a measurement report

» Tap Data

; Cartesian
- position

ENTERPRISE

Default settings

Page header

Report header

Figure 35: The data table of a measurement report template

1 The different sections of the template can be edited in the editor menu.

2 The data table in the template can be adjusted.

3 The list shows the form fields that can be inserted into the data table.

4 'Grid" operating element for displaying and hiding the auxiliary lines in the
editor.

» Tap Grid to display or hide the grid of auxiliary lines

ﬁ

o The grid of auxiliary lines is always active. All
fields of the form are automatically aligned with
it.
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Selecting the data for the measurement report

The form fields listed below can be inserted into the data table of the
measurement report. During the creation of the measurement report, the data are
filled in according to the entries made and depending on the measured features.

» To insert or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark

> The form field is inserted as a column into the data table or
removed from the data table.

Form field Meaning and application

Name The name of the feature is inserted.
Number The number of the feature is inserted.
Type The feature type is inserted.

Cartesian position

The position in Cartesian coordinates is inserted.

Polar position

The position in polar coordinates is inserted.

X The X coordinate (Cartesian) is inserted.
Y The Y coordinate (Cartesian) is inserted.
z The Z coordinate (Cartesian) is inserted.

Coordinate system

The coordinate system that is used for the feature
is inserted.

r The radial coordinate (polar) is inserted.

(0] The angular coordinate (polar) is inserted.

Size The main dimension of the feature (e.g., the length
of a straight line) is inserted.

Length The length of the feature is inserted.

Width The width of the feature is inserted.

Radius The radius of the feature is inserted.

Diameter The diameter of the feature is inserted.

Angle The angle of the feature is inserted.

Fitting algorithm The fitting algorithms used on the feature or on the

activated tolerances are inserted.

No. of points / parent

features

For measured features, the number of measuring
points is inserted. For constructed features, the
number of parent features is inserted.

Form deviation

The maximum deviation from the calculated ideal
form is inserted.

0 Applies only to features that have
been measured using more than the
mathematically required number of
points.

Creation type

The symbol for the process with which the feature
has been generated is inserted (measuring,
constructing, or defining).
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Form field

Meaning and application

Tolerance general state

The overall status of all of the tolerances that have
been inserted into the feature are inserted (e.qg.,
Passed, if all of the individual tolerances are good).

Tolerance type

The tolerance types applied to the feature are
inserted.

Tolerance state

The statuses of the tolerances applied to the
feature are inserted.

Nom. dimension / Toler-
ance zone

The nominal dimension or the value of the toler-
ance zone of a tolerance applying to a feature is
inserted.

Actual value

The actual dimension of a tolerance applied to the
feature is inserted.

Deviation

The difference between nominal dimension and
actual dimension is inserted.

Lower tolerance

The lower tolerance limit of a tolerance applied to
the feature is inserted.

Upper tolerance

The upper tolerance of a tolerance applied to the
feature is inserted.

Lower limit

The lower limit of a tolerance applied to the feature
is inserted.

Upper limit

The upper limit of a tolerance applied to the feature
is inserted.

Trend [-/+++]

The trend of the deviation is inserted.

The tolerance zone is divided into seven segments.
The result is assigned to the corresponding
segment. The corresponding segment is shown as
a trend:

B Segment -3: ---
B Segment -2: --

® Segment-1: -

= Segment 0:.

® Segment +1: +

B Segment +2: ++
B Segment +3: +++

Reference, bonus

The reference feature of a tolerance applied to the
feature is inserted.

If a material requirement is being used, the exist-
ing tolerance bonus is inserted.
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Adjusting the data table

You can resize the data table with the square handles at the corners of the data
table. The sequence of form fields in the list determines how the columns are
arranged in the table. To adjust the width of the columns in the data table, use the
diamond-shaped handles.

>
>

A\

Tap Grid to use auxiliary lines for easy alignment

Use the square handles to resize and position the data table
as needed

To rearrange the columns, long press the form field in the list
and drag it to the desired position in the list

Adjust the column width with the diamond-shaped handles
Columns that are outside the print area are marked red
The changes to the data table are applied

6.2.6 Saving a template
The templates are saved in the XMT data format.

4

VvV v vV VvV YV

To save the template, tap Save as

The Save as dialog appears

Select the storage location (e. g., Internal/Reports
Enter a name for the template

Confirm entry with RET

Tap Save as

The template is saved and can be used for measurement
reports

6.2.7 Exiting or canceling the creation of a template

o When creating a template, you need to save the template before
closing it. Otherwise, the editing process will be canceled and the
changes will be discarded.

Further information: "Saving a template”, Page 81

4

>
>

6.3 Transferring a measurement report template to the unit

Tap Close to exit or cancel the creation of the template or
measurement report

Tap OK to close the message
The editor is closed

You can transfer a measurement report template from a computer to the unit over
a network or via a USB mass storage device.
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Storing a file to a network drive or USB mass storage device

» In your computer’s file storage area, navigate to the folder in
which have saved the measurement report template (e.g.,
C: » HEIDENHAIN » [product designation]
» ProductsMGES5 » [product code] » user » Reports
» custom_templates

» Copy the file to a network drive or USB mass storage device

Import the file into the unit

> Tap File management in the main menu

On the USB mass storage device or network drive, navigate
to the file you want to import

Drag the icon of the file to the right
The operating elements are displayed
To copy the file, tap Copy file

In the dialog, select the following storage location:
» Internal » Reports » custom_templates

Tap Select
The file is stored on the product

> The template appears in the Measurement report menu and
can be used for creating measurement reports

ﬁ

vV vV y v

v Vv
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ScreenshotClient | Overview

Overview

The standard installation of QUADRA-CHEK 2000 Demo also contains the
ScreenshotClient program. With ScreenshotClient, you can take screenshots of
the demo software or the unit.

This chapter describes how ScreenshotClient is configured and used.

Informationen about ScreenshotClient

With ScreenshotClient, you can take screenshots of the active screen of the
demo software or the unit from a computer. Before taking a screenshot, select the
desired user interface language, as well as the file name and the location where
you want to store the screenshots.

ScreenshotClient creates image files of the desired screen:

® |n .PNG format

= With the configured name

= \With the appropriate language code

5 With the time information of year, month, day, hour, minute, and second

Connection 127.0.0.1
Identifier C:\HEIDENHAIN\screenshot
Language o all de\ fr a
N\,
[2] Screenshot was taken successfully.
[1] Connection established.
[0] Screenshot Client started. 3

Figure 36: ScreenshotClient user interface

1 Connection status

2 File path and file name
3 Language selection

4 Status messages
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ScreenshotClient | Starting ScreenshotClient

73 Starting ScreenshotClient

> Select in succession in Microsoft Windows:
= Start
u All programs
= HEIDENHAIN
= QUADRA-CHEK 2000 Demo
® ScreenshotClient
> ScreenshotClient is started:

Connection 127.0.0.1

Identifier

Language

[0] Screenshot Client started.

Figure 37: ScreenshotClient has been started (not connected yet)
> You cannot connect ScreenshotClient with the demo software or with the unit

74 Connecting ScreenshotClient with the demo software

0 Before establishing a connection with ScreenshotClient, first start the
demo software or switch on the unit. Otherwise ScreenshotClient will
show the status message Connection close. when trying to connect

» Start the demo software if you have not already done so
Further information: "Starting QUADRA-CHEK 2000 Demo", Page 23

Tap Connect

A connection with the demo software is established
The status message is updated

The Identifier and Language input fields become active

VVVY
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ScreenshotClient | Connecting ScreenshotClient with the unit

Connecting ScreenshotClient with the unit

Prerequisite: The network must be configured on the device.

@ For detailed information on configuring the network at the unit, please
refer to the “Setup” chapter in the operating instructions of QUADRA-
CHEK 2000.

o Before establishing a connection with ScreenshotClient, first start the
demo software or switch on the unit. Otherwise ScreenshotClient will
show the status message Connection close. when trying to connect

v

Switch on the unit if you have not already done so

Enter the IPv4 address of the interface in the Connection input field.
You will find the address in the unit settings under: Interfaces » Network »

Tap Connect

A connection with the unit is established

The status message is updated

The Identifier and Language input fields become active

v

VVVY

Configuring ScreenshotClient for taking screenshots
Once you have started ScreenshotClient, you can make the following
configurations:

= | ocation at which screenshots are stored, and what the file names are

®  User interface language in which the screenshots are created

Configuring the storage location and file name for screenshots

By default, ScreenshotClient saves screenshots to the following storage location:

C: » HEIDENHAIN » [product designation] » ProductsMGE5 » Metrology
» [product code] » sources » [file name]

You can define a different storage location, if necessary.
> Tap the Identifier input field

> Enter the path to the storage location and the name for the screenshots into
the Identifier input field

0 Use the following syntax to enter the path and file name for
screenshots:

[drive]:\'folder]\file name]

> ScreenshotClient will save all screenshots to the storage location entered
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ScreenshotClient | Configuring ScreenshotClient for taking screenshots

76.2 Configuring the user interface language of screenshots

The Language input field shows all of the user interface languages available
for the demo software or the unit. Once you have selected a language code,
ScreenshotClient will take screenshots in the corresponding language.

o The user interface language you are using in the demo software or on
the unit does not have any effect on the screenshots. Screenshots
are always created in the language that you have selected in
ScreenshotClient.

Screenshots in the desired user interface language

To take screenshots in a desired user interface language

» Use the arrow keys to select the desired language code in
the Language input field

> The selected language code is shown in red
@ > ScreenshotClient creates the screenshots in the desired user

interface language

Screenshots of all available user interface languages

To create screenshots in all available user interface languages

> Use the arrow keys to select all in the Language input field

[ 4 > The all language code is shown in red

{ 3 ) > ScreenshotClient creates the screenshots in all available user
4 interface languages
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Creating screenshots

» In the demo software or on the unit, call the view from which you would like to
take a screenshot

» Switch to ScreenshotClient

» Tap Snapshot

> The screenshot is created and saved to the configured storage location

o The screenshot is saved in the format [file
name]_[language codel_[YYYYMMDDhhmmss]
(e.g. screenshot_en_20170125114100)

> The status message is updated:

127.0.0.1

Identifier C:\HEIDENHAIN\screenshot

Language [G all de fr o]

[2] Screenshot was taken successfully,
[1] Connection established.
[0] Screenshot Client started.

Figure 38: ScreenshotClient after screenshot has been created successfully

Exiting ScreenshotClient

Tap Disconnect

v

> The connection to the demo software or the unit is terminated
» Tap Close
> ScreenshotClient is exited
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